INTRODUCTION

Cork is a plant tissue formed by cells filled with a gas mixture similar to air and bound by natural polymers, the main components being suberin (45%), lignin (27%) and polysaccharides (12%). This extraordinary product of nature is nothing more, nothing less than the bark of the cork oak, the only tree with an auto renewable bark.

Portugal accounts for almost 50% of the global cork oak area and is the largest cork producer in the world, contributing with 55% of the annual world production.

Cork removal is performed only by specialized professionals who manage to extract the bark without damaging the tree so that the oak can be stripped every nine years. However, a cork oak needs to be 25 years old before it can be stripped for the first time. This first cork can be used as raw material for thermal and acoustic insulation products. Cork is widely exploited due to its unique properties and today its industrial application goes far beyond cork stoppers and cork flooring. For example the Vega rocket from the European Space Agency's (ESA) was launched into space in 2012 and, in order to prevent the rocket from overheating, cork was placed in the nose cone and other areas sensitive to temperature. In a Sustainable Development context, cork can play a relevant role, because it is a natural, renewable, recyclable and non-toxic resource, with exceptionally good environmental qualities, and a high potential of innovative technological characteristics.

On a trip to the province of Alentejo, two friends, Vasco and Isabel, were very surprised when they saw large beautiful trees which bark had just been removed.

They approached the workers and asked if that process might harm the trees. The workers smiled at them and explained that this particular bark they were extracting was simply cork, the material that is used as bottle stoppers.

Isabel then remembered of pictures from her parents when they visited the Portugal Pavilion at Expo 2000 in Hannover (Figure A), whose walls were made of cork! They were really curious and decided they wanted to learn more about this fantastic oak tree, the cork that it produces and its possible applications.

Figure A – Portugal Pavilion at Expo 2000 Hannover.
Álvaro Siza Vieira and Eduardo Souto Moura, Pritzker Prize winners, Portuguese architects, used pure expanded cork boards and high density cork boards as external coating on some facades of the building.

In this task you will get to know a little more about cork and, hopefully, you will understand why it is considered an extraordinary natural product.

With this aim, you will show Vasco and Isabel how to identify the best cork-producing tree that will allow making premium wine bottle stoppers. You will also show them how to evaluate the quality of a cork stopper and will demonstrate that cork can really be an efficient thermal insulator.
This assignment includes 4 individual tasks which consist on:

Task 1 - 1 – Identification of Key Characteristics of Cork and of the Cork Producing Tree  
60 Marks

Task 1 - 2 – Selection of the Perfect Cork Plank to make Premium Wine Bottle Stoppers  
60 Marks

Task 1 - 3 – Determination of Phenolic Content and Evaluation of Cork Quality.  
120 Marks

Task 1 - 4 – Cork as Thermal Insulator  
120 Marks
**TASK 1 - 1.: IDENTIFICATION OF KEY CHARACTERISTICS OF CORK AND OF THE CORK PRODUCING TREE**

**Introduction**

There are approximately 200 species listed under the genus *Quercus*, but only one species has the ability to continuously produce a structure with technological characteristics that make it highly valuable. This structure is commonly called cork and it is a protective structure named phellem by plant anatomists.

Cork is evaluated according to its quality, with two main physical-chemical factors being evaluated: plank thickness and plank porosity. Plank thickness relates with cork annual growth, i.e. the number of cells produced per year. Currently, the cork production cycle takes 9 years, the annual rings being visible in the planks (Figure 1 - 1.1). Cork planks are classified according to its thickness and are normalised into calliper classes. However, there is not a direct relationship between thickness and quality. Very thin planks are not suitable for industry purposes while thick planks have too much gas permeability (negative trait for cork quality). When having a suitable plank thickness, the plank is evaluated for its porosity which is determined by the lenticular channels that cross radially the cork plank.

![Figure 1 - 1.1 – Schematic representation of a cross-sectoral plan of a cork oak plank. The phellogen produces cork layers that develop radially with an annual physiological rhythm; nine annual growth rings are represented here (1, most recent; 9, older one). Cork bark (10) is exposed to the atmosphere. The phellogen (11) is in contact with the most recent growth ring (1).](image)

So, cork quality is the result of the individual genetic makeup and growth conditions, both abiotic (e.g. water availability) and biotic (e.g. pathogens that comprise tree growth or that compromise cork homogeneity).

Within this task you are asked to identify the cork producing tree (task 1 - 1) and to identify key characteristics of cork quality (task 1 - 2).
Materials and equipment

- Five Petri dishes with plant material (A - E), one per specimen (each individual represents one species) containing:
  - Leaves, fruits and stem ultrathin cuts (for Sudan red staining)
  - Cork micro slices for positive control for Sudan red staining (labelled as “+ Control”)
- Photographs of the branches, fruits, leaves and trees for each species (A - E)
- Appendix 1 “Morphological characteristics of the biological material”
- Microscope glass slides, 1 box
- Glass coverslips, 1 box
- Tweezers, 1 piece
- 20 μL Micropipette, 1 piece
- 20 μL Micropipette tips, 1 box
- Deionized water in 10 mL test tube, 1 piece (labelled as “H₂O”)
- Sudan red reagent in 10 mL test tube, 1 piece (labelled as “Sudan Red”)
- Ethanol 70% in 10 mL test tube, 1 piece (labelled as “EtOH”)
- Pasteur pipettes, 3 pieces
- 24 well plate, 1 piece
- 500 mL plastic beaker for waste, 2 pieces
- Timer also to be used in Task I.3, 1 piece
- Optical microscope, 1 piece
- Stereomicroscope - shared (one per two working groups)

If you spill a chemical or break a piece of glassware or destroy the biological material and you need a replacement, request the help of the lab assistant.

Any additional material from the list above mentioned will cost you 5 marks unless otherwise stated. Additional biological samples will cost you 10 marks.

1 - 1.1. Identification of the cork producing tree

In your workstation you will find 5 Petri dishes with biological samples – named A, B, C, D and E - from five different trees, one of them is the cork producing tree. Please be very careful when handling the thin sections.

In this task you are asked to identify the 6 species to which each specimen belongs to, following a set of experimental activities.

Fill in the following table that will lead you to the characterization and identification of the 5 trees (A, B, C, D and E). For that you will need to use the biological samples in the plate, the photos and the Appendix 1 provided.

When filling in the table, indicate with a cross (X) the characteristics that best fit your observations and/or experimental results. It may be the case that there is more than one correct option for each specimen. Be sure to clearly indicate all that apply.

If you select incorrect options, this will cost you 20% of the marks per option.

If you do not select all the options that apply, this will cost you 10% of the marks per option.
1.1.1. Instructions for the experimental procedure

Read the table carefully before you start your observations.
To avoid multiple observations of the same material (getting in and out of the plate), observe all the characteristics under the optical microscope or stereomicroscope that are asked to fill the table.

Observation of the biological material provided AND photographic handout;

1. Leaf trichomes (“hairs”) observation at the microscope: put the leaf on the top of a slide; turn on the microscope and observe at lower magnification. Observe both sides of the leaf (upper and lower). Observe all the leaves available, and within each leaf observe multiple areas.

2. Water droplet test: select one leaf and use a micropipette to measure a drop of 10 µL of water. Gently apply, without pressing, the drop on each of the surfaces of the leaf (upper and lower). Apply at least 10 drops per leaf surface, in different parts of the same leaf. Be sure to apply one drop on the middle vein and another drop on a surface that is not in contact with the middle vein.

3. Observe the water droplet under the stereomicroscope to determine its shape.

4. When analysing the lower surface, and after the droplet test, lean the leaf at 90° and check if the drop slips or changes shape. Answer the question based on the behavior of at least 6/10 drops.

5. Dry the droplets with paper and return the biological material to the respective Petri dishes.

6. Sudan Red test: Use the 24 wells plate to stain the young stems slices. Use three wells per species. Pipette 0.5 ml of Sudan Red stain, 0.5 ml of 70% ethanol or 0.5 ml of water per well (as suggested in the figure below). You can find all these reagents in tubes of 10 ml and with the correct label. Use the provided tweezers to pick the cuts and pass them through the solutions.

Insert the slices in the 70% ethanol solution for 1-2 min, then insert them in the Sudan Red solution and incubate for 10 min; take the slices off and wash them in the previous 70% ethanol solution (1-2 min); pass the slices through distilled water (1-2 min) and mount them in a slide, with a drop of water and a coverslip.

Observe the preparation under the microscope. Look at several different pieces. In addition to the 5 tree samples, you also need to stain the positive control.

Proposed layout:

<table>
<thead>
<tr>
<th></th>
<th>A1</th>
<th>A2</th>
<th>A3</th>
<th>A4</th>
<th>A5</th>
<th>A6</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Wells A1 to A6** – use for the 70% ethanol solution;
- **Wells B1 to B6** – use for Sudan Red solution;
- **Wells C1 to C6** – use for water;
- **Wells D1 to D6** remain empty.

Use wells A1 to C1 for specimen A, A2 to C2 for specimen B, and so on. Use wells A6 to C6 for the positive control.
Read the Table and optimize the use of the microscope and stereo microscope. The swap of biological material between Petri dishes will cost you 20 marks.

**Question 1.1.a**

Following the instructions provided, fill Table 1.1.a in the answer sheet:

❖ Enter the biological material dataset ID number in the answer sheet.
❖ Enter your results under Question 1.1a. in the answer sheet.

**Question 1.1.b**

On completing your observations, use the dichotomous key to identify the species present in each Petri dish. On the answer sheet, in Table 1.1.b, make a correspondence between the Petri dish letter and the name of the tree

❖ Enter your results under Question 1.1.b in the answer sheet.

**Question 1.1.c**

In which leaf surface would you expect to find stomata?

❖ Enter your answer under Question 1.1.c in the answer sheet.

**Question 1.1.d**

A highly pubescent leaf is expected to:

❖ Enter your answer under Question 1.1.d in the answer sheet.

**Question 1.1.e**

If you are asked to determine if these trees are monocotyledonous or dicotyledonous, which plant organ would you use?

❖ Enter your answer under Question 1.1.e in the answer sheet.

**Question 1.1.f**

You were asked to perform the Sudan Red staining in young stems of the several specimens. You probably notice a dark layer in the most external part of the sections. Can you provide the most probable function of this layer?

❖ Enter your answer under Question 1.1.f in the answer sheet.
TASK 1 - 2.: SELECTION OF THE PERFECT CORK PLANK TO MAKE PREMIUM WINE BOTTLE STOPPERS

Introduction

Now that you have succeed to identify which sample belongs to a tree of *Quercus suber*, commonly known as the cork oak, we need your help in determining which sample of cork planks should be used for wine bottle stoppers.

Cork planks from three different trees, which represent three different types of cork, were collected for your analysis (Figure 1 - 2.1). Please take some moments to analyse the texture, the porosity and imperfections present in your cork samples. Cork planks enriched in lesions, or with the inappropriate width, are not suitable for making wine bottle stoppers.

![Images of cork planks](image)

Figure 1 - 2.1 – Images obtained from the lateral area of each plank are shown below (labeled A to C).

It is possible to observe the environmental effects on each particular tree. Cork cells do not grow on Winter, they only grow in Spring and Summer. The growth rate depends on the physiological conditions of the tree and the amount of water available. During Spring, you may observe more cell divisions, which result in larger cells with thinner cell walls. During Summer there are fewer cell divisions, which result in cells with cell walls differently assembled (tougher and darker).

The environmental conditions are reflected in each tree growth rings and the analysis of the width of the tree rings can give you further information about the growing conditions, namely climate effects, insect attacks, fire and light availability.

In this task, you need to determine the average fraction of the cork material with imperfections of 3 cork planks shown in Figure 1 - 2.1 (one sample of each cork plank is available in the laboratory in case you want to briefly observe these imperfections). The sample with a suitable thickness and lowest fraction of imperfections should be the best for bottle stoppers production.
Materials and equipment

- Computer
- Cork sets for hands-on observation of cork - shared. One cork set with 3 samples is available per Laboratory.

1 - 2.1. Cork plank quality control: quantification of imperfections

Follow the procedure described below:

1. Open the program ImageJ on the Desktop.
2. In ImageJ, open files named A to C (command File>Open) that are on the Desktop (Folder Images_EUSO). These image files have been taken with a digital scanner and saved in RGB color format.
3. Extract the information in each channel by applying the command Image>Color>Split Channels. This command will extract the information in the Red, Green and Blue Channels into three different images.
4. To each image apply the command Image>Lookup Tables>Grays (to change the color of each frame to Gray). Then apply the command Image>Adjust>Brightness/Contrast (to adjust the intensity of the pixels in each image) and choose the option Auto. Finally choose the option File>Save As>Tiff (to save each image in a TIFF format). Alter the name of each image to any chosen designation that clearly identifies the colour.
5. For each plank (samples A to C) you get three images. For each sample, decide which image to use in the next steps.

Question 2.1.a

Which channel(s) allows you the best observation of the growth rings?

❖ Enter your results under Question 2.1.a in the answer sheet.

6. After choosing the image you want to analyze, save it with a different name such as “Image_1.tif”. Then open the image with the command File>Open and choose the button in the toolbar that corresponds to the Rectangle Selection (1st button from the left side). Select the area of the cork you want to analyze. Do not include the black background.
7. Copy the information inside the selection by choosing the command Edit>Copy to System.
8. Choose the option File>New>System Clipboard. This step will paste the information that you have copied into a new RGB file.
9. Choose the option Image>Type>8-bit to convert the file from a RGB Color format into a 8-bit format.
10. Choose the option File>Save As>Tiff (to save the selected region in a TIFF format). Save as Image_A_crop_1.tif.
11. Choose the option Image>Adjust Threshold and define the intensities of the pixels in the “Threshold” window in order to include the dark areas you want to quantify. If you are happy with the selected regions choose “Apply”. The selected regions will be colored with white and a pixel intensity of 255. The other regions will be colored with black and a pixel intensity of 0.
12. Choose the option Analyze>Set Measurements and define what you want to measure and the number of decimal places.
13. Choose the option Analyze>Measure and record the values obtained in the window “Results”. This is the area of the entire image you have in pixels\(^2\) (pixel x pixel).

14. Close the window “Results”.

15. In order to save an image with the area with white pixels, use the option File>Save As>Tiff. Save as Image_A_crop_1_threshold.tif

16. Choose the option Analyze>Analyze Particles and decide which parameters you will need. We propose that you choose the option “Outlines” in “Show:” (to observe the regions that have been selected) and that you click the option “Display Results” and “Add to Manager” (to save the results in a file that you can open using the OpenOffice spreadsheet also available on the Desktop). Then click “OK”.

17. You will be able to select each assembled Region of Interest (ROI) in the window “ROI Manager” and see where it is in the window with your image. Select all the ROI and save the file in the same folder you have been saving all your ImageJ files. The values of the area for each ROI are shown in the window “Results” in pixels\(^2\).

Do not forget to organize and save your files so that it is possible to confirm that you have executed correctly the proposed protocol. This information will be considered in the classification of questions 2.1.b to 2.1.e.

Question 2.1.b

How many files have you produced with the protocol you followed to determine the percentage of area with imperfections in the cork samples A to C? Please include the files you have produced with the spreadsheet based software that is available in your computer.

❖ Enter your results under Question 2.1.b in the answer sheet.

Question 2.1.c

Which area of the cork samples A to C have you considered in the determination of the percentage of area with imperfections? Draw with waterproof marker the area in the answer sheet.

❖ Enter your results under Question 2.1.c in the answer sheet.

Question 2.1.d

Determine the percentage of area with imperfections in the different cork samples A to C. Which of the samples has the lowest percentage of area with imperfections? You will need to use the OpenOffice spreadsheet available in your computer.

❖ Enter your results under Question 2.1.d in the answer sheet.

Question 2.1.e

Take in consideration the area with imperfections, draw a bar plot with the sum of the dark regions present in the 3 cork planks. You should use the values measured in the previous question.

❖ Enter your results under Question 2.1.e in the answer sheet.
Question 2.1.f
How many growth rings can you easily observe in the plank A?
❖ Enter your answer under Question 2.1.f in the answer sheet.

Consider Figure 1 - 2.2 for the next questions, where you may detect 10 different layers that correspond to 10 consecutive growing years.

Figure 1 - 2.2 – Image of the lateral area of one of the planks that you have analyzed.

Question 2.1.g
Why do you think there are darker and lighter areas? Choose the best hypothesis.
❖ Enter your answer under Question 2.1.g in the answer sheet.

Question 2.1.h
In which year do you think it rained more?
❖ Enter your answer under Question 2.1.h in the answer sheet.

Question 2.1.i
Indicate which regions do you think correspond to Spring and Summer growth.
❖ Enter your answer under Question 2.1.i in the answer sheet.

Question 2.1.j
Which layer/growth ring has been exposed to the atmosphere?
❖ Enter your answer under Question 2.1.j in the answer sheet.
**TASK 1 - 3.: DETERMINATION OF TOTAL PHENOLIC CONTENT AND EVALUATION OF CORK QUALITY**

**Introduction**

Due to its unique physical and chemical characteristics, cork is an excellent seal for table wines, sparkling wines and liqueurs among others. As seen in the previous task (1 - 2), not all types of cork can be used in the manufacture of wine bottle stoppers.

Cork planks with too much permeability, or with the inappropriate width, are not suitable for making wine bottle stoppers. This is because cork aromas can have an effect on the sense of smell and taste of wine.

The complexity of cork aromas is sometimes associated with the appearance of sensory defects in wine. This may arise as a consequence of the presence of exogenous chemicals of microbiological origin. Although the percentage of appearance of aroma defects associated with the use of cork stoppers is very low, producers of cork stoppers have been making efforts to apply appropriate quality control methods. Among these, in the cork stoppers sensorial analysis it is important to evaluate the presence of 2,4,6-trichloroanisole (TCA), that cause the mould smell/taste in wine.

The formation of TCA occurs when microorganisms, such as fungi, come into contact with chlorine-based compounds, usually chlorophenols, as represented in Figure 1 - 3.1

![Figure 1 - 3.1 – Production pathway of 2,4,6-trichloroanisole (TCA).](image)

1 - Lignin; 2 - Phenol; 3 - 2,4,6-Trichlorophenol (TCP); 4 - 2,4,6-Trichloroanisole (TCA); A - Fungi; B - Filamentous fungi biomethylation

Since phenol is itself a product of degradation of the polymeric structure of cork, the quantitative determination of phenol present in cork is an important parameter to determine, not only its quality, but essentially its possible applications.

In this task you will determine the amount of phenol present in cork samples and thus classify cork in terms of its quality to be used in the production of cork stoppers.

Phenolic quantification assay is based on Folin-Ciocalteu (FC) reagent. The FC reagent contains phosphomolybdic/phosphotungstic acid complexes. The method relies on the transfer of electrons in alkaline solution from phenolic compounds to form a blue chromophore constituted by a
phosphomolybdenum/phosphotungsten complex. Its colour intensity depends on the concentration of phenolic compounds. The reduced FC reagent is detectable with a spectrophotometer in the range of 600 to 710 nm.

In the quantitative analysis of phenols, the Lambert-Beer law will be used. It relates the concentration of a compound with its absorbance.

\[ A = \varepsilon b C \]

This law predicts a linear relation between the absorbance reading \((A)\) and the molar concentration of the compound \((C)\), if \((b)\), the cell or cuvette width, is kept constant. \(\varepsilon\) is a constant defined as the absorptivity and is characteristic of the compound and solvent media. Thus, it is possible to determine the concentration \((\text{mg}\cdot\text{L}^{-1} \text{ or } \text{mol}\cdot\text{L}^{-1})\) of a given compound in a solution through the absorbance of that solution if the cell length \((\text{cm})\) and the absorptivity \((\text{L}\cdot\text{mg}^{-1} \cdot \text{cm}^{-1} \text{ or } \text{L}\cdot\text{mol}^{-1} \cdot \text{cm})\) are known.

**Materials and equipment**

- Volumetric flask, 50 mL, 10 pieces
- Graduated beakers, 25 mL, 15 pieces
- Volumetric pipette 3 mL, 2 pieces
- Volumetric pipette 5 mL, 1 piece
- Volumetric pipette 10 mL, 1 piece
- Volumetric pipette 20 mL, 1 piece
- Volumetric pipette 25 mL, 1 piece
- Pipette filler bulb, 1 piece
- 1000 μL micropipette, 1 piece
- 1000 μL micropipette tips, 1 box
- Disposable plastic Pasteur pipettes
- 1 cm length/2 mL plastic cuvettes, 3 pieces
- 500 mL plastic beaker for waste, 2 pieces
- Waterproof marker, 1 piece
- Deionized water in 500 mL plastic wash bottle, 2 pieces (labelled as “H₂O”) (can be refilled if needed without penalty)
- Stock solution of gallic acid \((0.00050 \text{ mol/L})\), 100 mL (labelled as “Gallic Acid”)
- Stock solution of Folin-Ciocalteu, 20 mL (labelled as “Folin”)
- Stock solution of sodium carbonate \((7.5\% \text{ w/w})\), 20 mL (labelled as “Na₂CO₃”)
- Three samples of cork extracts (labelled as “Lot A”, “Lot B”, “Lot C”), 2 mL each
- Colorimeter, 1 piece
- TI-Nspire CX calculator, 1 piece
- Scientific calculator TI-30X, 1 piece
- Timer also to be used in Task 1 - 1, 1 piece

If you spill a chemical or break a piece of glassware and you need a replacement, please request the help of the lab assistant.

Any additional above mentioned material will cost you 5 marks unless otherwise stated. Additional samples will cost you 10 marks.
1 - 3.1. Calibration curve slope (m)

The first task is to determine the term $\varepsilon_b$ from the Lambert-Beer law, that is the slope $m$, using a set of solutions of known concentrations (standard solutions) that will be prepared from a stock solution of gallic acid ($5 \times 10^{-4}$ mol/L). Gallic acid is traditionally used to determine the Total Phenolic Content (TPC) in various materials.

Prepare 50 mL of each standard solution using the volumes indicated in the Table 3.1 by using the pipette filler bulb (see in Appendix 2) and the appropriate pipette.

Table 3.1

<table>
<thead>
<tr>
<th>Standard</th>
<th>Stock solution 0.0005 mol.L$^{-1}$ Volume to add in mL</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>3.00</td>
</tr>
<tr>
<td>S2</td>
<td>5.00</td>
</tr>
<tr>
<td>S3</td>
<td>10.00</td>
</tr>
<tr>
<td>S4</td>
<td>20.00</td>
</tr>
<tr>
<td>S5</td>
<td>25.00</td>
</tr>
</tbody>
</table>

Question 3.1.1.

Calculate the concentration of the standard solutions prepared by you (in mg.L$^{-1}$). Indicate the obtained value with 2 decimal places.

❖ Enter your calculations and results in the answer sheet, under Question 3.1.1 in the Table.
1 - 3.1.1. Samples for calibration curve

1. Carefully transfer 0.5 mL of each standard solution into a 25 mL beaker and add 0.5 mL of the FC reagent, stir, **wait 3 minutes** and then add 0.5 mL of the Na2CO3 solution.

2. Prepare the blank solution following the instructions in point 1. but using 0.5 mL of H2O instead of the standard solution.

3. Stir and leave to stand for **30 minutes**.

4. Connect, wait approximately 5 minutes and calibrate the colorimeter (see instructions for Vernier Colorimeter in Appendix 3).

5. After 30 minutes, read the absorbance of the solutions at the wavelength of 635 nm using the colorimeter. Indicate the obtained value with 2 decimal places.

**Question 3.1.2.**

❖ Record the value in the Table of the answer sheet under Question 3.1.2.

**Question 3.1.3.**

By plotting the absorbance ($A$) versus the gallic acid concentration ($C_{gallic\ acid}$), the absorptivity of the compound (use the appropriate cell length) can be determined from the slope ($m = \varepsilon$) of a straight line ($y = mx$) that best approximates the experimental data points.

❖ Register the plot in millimeter paper under Question 3.1.3 in the answer sheet.

**Question 3.1.4.**

From the $A$ and $C_{gallic\ acid}$ data determine the **slope** of the straight line that best fits the experimental data points.

The straight line that best fits the experimental data points can be determined by the least squares fitting method. The least squares fitting method is based on the minimization of a function that computes the sum of the squares of the differences between the expected values of $A$ and its corresponding experimental values.

To do this, start by calculating the sums according to the following example Table.

Example of the calculations for the determination of the slope using the least squares fitting method.

<table>
<thead>
<tr>
<th>$(x)^2$</th>
<th>$x_i \times y_i$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x_1^2$</td>
<td>$x_1 \times y_1$</td>
</tr>
<tr>
<td>....</td>
<td>....</td>
</tr>
<tr>
<td>$x_5^2$</td>
<td>$x_5 \times y_5$</td>
</tr>
<tr>
<td><strong>S$x^2$ = Sum of $(x)^2$</strong></td>
<td><strong>$Sxy = Sum of (x_i \times y_i)$</strong></td>
</tr>
</tbody>
</table>
Calculate $m$ as follows:

$$m = \frac{S_x \times S_y}{S_x^2}$$

❖ Fill the Table in Question 3.1.4 in the answer sheet with the sums you need to calculate the slope

❖ Enter your calculations and results of $m$ under Question 3.1.4 in the answer sheet

❖ Record the value of the molar absorptivity of gallic acid

In the plot $A$ versus $C_{\text{gallic acid}}$ and using the calculated value for $m$ you draw the straight line that best fits the experimental points.

❖ Use the Plot of Question 3.1.3 in millimeter paper in the answer sheet to draw the straight line.

1 - 3.2. Limit of Detection – LOD

The limit of detection, LOD, is a very important parameter that determines the degree of confidence with which a given concentration can be measured. When studying samples of concentration below the detection limit of a technique, it is usually necessary to add a sample concentration step.

For any given technique the LOD can be calculated as 3 times the maximum standard deviation ($\sigma$) of the measurement divided by the slope of the calibration plot according to IUPAC (International Union of Pure and Applied Chemistry).

$$\text{LOD} = \frac{3\sigma}{\text{slope}}$$

Any signal measured in the real world has an associated uncertainty, that is a fluctuation around an average value, that affects the precision of the measurement. For instance, if a solution of a given concentration is prepared several times by weighting the same amount of compound and dissolving it in the same amount of solvent, different final concentrations will be obtained.

The standard deviation is related with the distance between the measured values and the average value of the measurements and is affected by the uncertainty that is involved in the preparation and in the measurement.

Determine the uncertainty in the measurements of the absorbance at 635 nm by preparing 5 replicates of the standard solution 1. For each one:

1. Measure 0.5 mL of each standard solution into a 25 mL beaker and add 0.5 mL of Folin-Ciocalteu reagent, stir, wait 3 minutes and then add 0.5 mL of Na$_2$CO$_3$.

2. Prepare a blank following the instructions in point 1. but using 0.5 mL of H$_2$O instead of the sample.

3. Stir and leave to stand for 30 minutes.

4. After this period determine the absorbance of the 5 solutions at 635 nm using the colorimeter. Indicate the obtained value with 2 decimal places.

❖ Record the value in the Table in the answer sheet under Question 3.2.1
In statistics, the standard deviation (σ) is a measure that is used to quantify the amount of variation or dispersion of a set of data values. A low standard deviation indicates that the data points tend to be close to the mean (also called the expected value) of the set, while a high standard deviation indicates that the data points are spread out over a wider range of values.

For a finite set of numbers, the standard deviation is obtained by taking the square root of the average of the squared deviations of the values from their average value.

For example, if we have obtained the values 2; 4; 4; 4; 5; 5; 7; 9 from 8 successive measurements, the average of the measurements is 5. First, calculate the deviations of each data point from the mean, and square the result of each, to obtain the squared deviations:

\[(2-5)^2=9\]
\[(4-5)^2=1\]
\[(4-5)^2=1\]
\[(4-5)^2=1\]
\[(5-5)^2=0\]
\[(5-5)^2=0\]
\[(7-5)^2=4\]
\[(9-5)^2=16\]

Calculate the mean of these values (called variance) and you will obtain 4. The standard variation is the square root of the variance \(\sigma = 2\)

Question 3.2.2.

From the standard deviation and the slope you should determine the LOD of the total gallic acid content.

❖ Enter your calculations and results in the answer sheet, under Question 3.2.2

1 - 3.3. Cork extracts analysis and evaluation

The cork planks A, B, C, from previous task 1 - 2, were subjected to an extraction procedure and the obtained extract was concentrated 10 times and stored at -20 °C to ensure its conservation. Three samples of cork extracts (Lot A; Lot B; Lot C) are supplied to be analysed.

1. Carefully transfer 0.5 mL of the "Lot A" sample into a 20 mL beaker and add 0.5 mL of Folin-Ciocalteu reagent, stir, wait 3 minutes and then add 0.5 mL of Na₂CO₃. Stir and leave to stand for 30 minutes.

2. Repeat point 1. for each of the "Lot B" and "Lot C" samples.

3. Prepare a blank following the instructions in point 1. but using 0.5 mL of H₂O instead of the sample.
4. After this period of **30 minutes** determine the absorbance at 635 nm and record the value in the Table under Question 3.3.1.

❖ **Record the value in the Table in the answer sheet, under Question 3.3.1.**

**Question 3.3.2.**

Determine the total phenolic content present in the cork samples provided and register the values in the answer sheets.

❖ **Enter your calculations and record the value in the Table under Question 3.3.2 in the answer sheet.**

**Question 3.3.3.**

The detection limit of the method is adequate to ensure direct measurement of the samples (i.e., without a concentration step)?

❖ **Answer under Question 3.3.3 in the answer sheet.**

**Question 3.3.4.**

Considering the provided information and the data gathered by your team in task 1 - 2 and 1 - 3, which plank would you chose as suitable for premium stoppers production?

❖ **Answer under Question 3.3.4 in the answer sheet.**
**TASK 1 - 4.: CORK AS A THERMAL INSULATOR**

**Introduction**

In this task you will explore another important characteristic of cork and its application in building construction.

The ability of a material to conduct heat is called the **thermal conductivity**. The air which fills the cork’s cellular structure makes it an excellent thermal insulator. As it provides a high level of thermal insulation, cork finds many uses, including in the building and aerospace industries. As an excellent thermal insulator, cork has a very low thermal conductivity.

**Thermal conductivity**

Heat is the energy transferred due to temperature difference (the energy is transferred from the higher to the lower temperatures). Heat transfer can occur via different mechanisms, namely conduction, convection and radiation. Conduction is a mechanism of heat transfer (or heat flow) within a body or between bodies in contact, that results from the transfer of kinetic energy through collisions taking place at a microscopic level. When a very small\(^1\) quantity of heat, or thermal energy, \(dQ\) is transferred in a very small\(^2\) time interval \(dt\), the heat flow, also called **heat current**, is defined as: \(H = \frac{dQ}{dt}\).

The heat current through an homogeneous body (see Figure 1 - 4.1) of length \(l\) (along the direction of the heat flow) and uniform cross-sectional area \(A\), when the temperature difference between its two ends is \(T_H - T_L\) (\(T_H\) and \(T_L\) are the higher and lower temperatures, respectively), is governed by the law:

\[
H = \frac{dQ}{dt} = k A \frac{T_H - T_L}{l},
\]

where \(k\) is a positive constant, which is a function of the constituting materials of that body, called **thermal conductivity**. As for the ratio \((T_H - T_L) / l\) it is the temperature difference per unit of length.

![Figure 1 - 4.1 – Heat conduction through a bar of length \(l\) and section \(A\), placed between two bodies that are at temperatures \(T_H\) and \(T_L\), respectively. The temperature difference between the two sides of the bar causes a heat flow from the higher temperature side to the lower temperature side, as represented by the arrow. The heat transferred through the bar, in a given time interval, depends on the temperature difference, the bar’s length \((l)\) and cross sectional area \((A)\) and on the thermal conductivity of the bar’s material \((k)\).](image)

The goal of this task is to determine the thermal conductivity of a thin sample of cork, by using the Lee’s disc method, described under 1 - 4.1.

---

\(^1\) \(dx\) denotes a very small amount of the quantity \(x\).

\(^2\) Note that, in general, the heat flow varies with time. Thus, to calculate an instantaneous measure of heat current, \(H(t)\), a very small time interval around \(t\) should be used.
Warnings:

Do not touch the hot steam generator. Never direct the steam stream towards you or your colleagues. Use the forceps whenever you have to move the hot steam chamber. Use the pot holder whenever you have to touch materials at high temperatures (steam generator; Lee’s disc and rubber tubes).

Materials and equipment (Figure 1 - 4.2)

- Steam generator (A) with a control slider (cs)
- Steam chamber (B)
- Brass disc (Lee’s disc) (C)
- Acrylic stand for Lee’s disc and steam chamber (D)
- A thin cork sample (E)
- Forceps (F)
- 2 calibrated temperature probes (thermistors) (G), to be connected to a TI-Nspire CX calculator, through a data logging Lab Cradle interface
- Texas Instruments TI-Nspire CX calculator with a data logging Lab Cradle interface (H)
- Thermal paste (to improve the thermal contact with the temperature probes) (labelled “Heat Sink Compound Plus”) (I)
- A thick cork insulator block (J)
- A large cork insulating base (K)
- Rubber tubes (L)
- Pot holder (M)

Figure 1 - 4.2 – General experimental materials and equipment.

The method comprises two parts using two different experimental setups.
1 - 4.1. Part 1 of Lee’s Disc Method

Figure 1 - 4.3 illustrates the first of two experimental setups that you will use to measure the thermal conductivity of a cork sample, using the Lee’s disk method. The cork sample (CK) is disc-shaped. You will place it between the cylindrical steam chamber (SC), and a brass disc – the Lee’s disc (LD) – which are mounted on an acrylic stand base.

When the steam generator, connected to the steam chamber, is turned on, the chamber heats up. The temperature, \( T_{SC} \), at the base of the steam chamber, just above the cork sample, can be measured by one of the thermistor (T-SC). A heat current, \( H_{in} \), flows from the chamber to the Lee’s disc through the cork sample, increasing the temperature of the Lee’s disc. The second thermistor (T-LD), measures the temperature of the Lee’s disc, \( T_{LD} \), which is in contact with the bottom surface of the cork sample. When \( T_{LD} \) increases above room temperature, heat also flows (through conduction and radiation) from the Lee’s disc to the environment. Thus, a heat current, \( H_{out} \), leaves the Lee’s disc. As \( T_{LD} \) increases, \( H_{in} \) decreases and \( H_{out} \) increases. When \( H_{in} = H_{out} \) a steady state is reached, and \( T_{SC} \) and \( T_{LD} \) remain constant at the values \( T_{H} \) and \( T_{L} \), respectively.

Procedure

1. Consider the following data: the mass of the Lee’s disc, \( m = 629 \) g; height of the Lee’s disc, \( h = 1.5 \) cm; diameter of the Lee’s disc, \( D = 8.0 \) cm and the thickness of the cork sample, \( d = 2.1 \) mm. Put this data in the answer sheet.

   ✤ Enter the data (in SI units) in the Table under Question 4.1.1. in the answer sheet.

2. Insert one of the temperature probes (T-SC) into the hole in the base of the steam chamber, and the other (T-LD) into the hole in the Lees’ disc. To ensure a good thermal contact with the temperature probes, you should smear the tip of each probe with thermal paste, prior to inserting the thermistors in each hole.
3. Connect the two temperature probes to the Lab Cradle data logging interface – to see how to do this and how to operate with the TI-Nspire CX calculator software see Appendix 3. Start to monitor the temperatures $T_{SC}$ and $T_{LD}$ using the TI-Nspire CX calculator (monitoring mode).

4. The pan of the steam generator is already half filled with water and ready to operate. Do not remove the hose or the retaining clamp. Connect the flexible tube from the steam generator to the inlet of the steam chamber (located close to its top). Connect the steam outlet (located close to the base of the steam chamber) to the nearest lab sink. Connect the hot plate of the steam generator to the power supply and set the heating level to “3.5-4” using the control slider. If there is any problem with the steam generation, please call a lab assistant.

5. Put the steam chamber in contact with the Lee’s disc. Turn on the steam generator and preheat the disc to the temperature, $T$, of 60ºC. This procedure is very fast. Do not exceed $T$= 65ºC. Use the forceps to hold tight the chamber, remove it from the acrylic stand and put it on top of the large cork insulating base (K in Figure 1 - 4.2). If the temperature exceeds 65ºC, wait until it cools back to that value, before proceeding to the next step.

6. Place the cork sample on the top of the Lee’s disc. Put the steam chamber, carefully and using the forceps, on the top of the cork sample. The cork should appear between the two brass components of the setup (see Figure 1 - 4.3). Note that the complete ensemble is now back to the acrylic stand. Ensure that the temperature probes remain correctly placed.

7. Restart monitoring the temperatures $T_{SC}$ and $T_{LD}$ with the TI-Nspire CX calculator. When $T_{SC}$ and $T_{LD}$ remain constant, record the values $T_H$ and $T_L$ on the answer sheet. Notice that this procedure may take a long time.

Experiment 1 - 4.1 is finished and you should now turn the control slider to ‘0’ (if you need to repeat this experiment call a lab assistant) and disconnect the temperature probe T-SC from the data logging Lab Cradle interface.

❖ Enter your results in Table under Question 4.1.2. in the answer sheet.

Question 4.1.3

In the answer sheet write the mathematical expression for the heat current, $H_{in}$, flowing into the Lee’s disk at the steady state. The expression should be written as a function of $k$ (the thermal conductivity of the cork sample) and of the appropriate symbols for other measured quantities.

❖ Enter your results under Question 4.1.3. in the answer sheet.

Question 4.1.4.

In the answer sheet, write the mathematical expression for $a$ in $H_{in} = k a$. This expression for $a$ should be written as a function of the appropriate symbols for measured quantities. From the measured values of those quantities, calculate an experimental value for $a$ (give details of your calculations and express the value in appropriate units).

❖ Enter your results under Question 4.1.4. in the answer sheet.
1 - 4.2. Part 2 of Lee’s Disc Method

The goal of this second part of the experiment is to measure how fast the Lee’s disc cools down, i.e., its cooling rate, \( r \), at the temperature when it reached the steady state. The cooling rate of the Lee’s disc is a function of its temperature. When the disc is at a given temperature, \( T \), its cooling rate is the ratio between a small temperature variation \( \Delta T_{LD} \) around \( T \), and the short time interval, \( \Delta t \), required for this variation to occur: \( r(T) = \frac{\Delta T_{LD}}{\Delta t} \). At the steady state, the cooling heat current from the disc to the environment, \( H_{out} \), can be related to the cooling rate by the expression:

\[
H_{out} = mc \frac{dT_{LD}}{dt},
\]

where \( m \) is the mass of the Lee’s disc and \( c = 377 \text{ J/ (kg K)} \) is the specific heat capacity of the disk material. The specific heat capacity is the heat required to raise the temperature by one degree Celsius of 1 kg of the material.

In the following procedure you will raise the temperature of the Lee’s disc about 5°C to 10 °C above \( T_L \) and then let it cool down, while continuously measuring the temperature of the disc. The cooling down is due to heat flowing from the disc to the environment.

Procedure

1. Remove the cork sample from the previous setup, using the provided pot holder and the forceps as protection.

2. Set the power of the steam generator to “3.5-4” using the control slider. If there is any problem with the steam generation, please call a lab assistant. In this part of the experiment the TI-Nspire CX calculator should be used in acquisition mode. Select an appropriate sampling rate. Start collecting data from the temperature probe \( T_{LD} \) and wait until \( T_{LD} \) reaches a value about 5°C to 10 °C above \( T_L \).

3. Turn the control slider to “0” and disconnect it from the power supply. Using the pot holder as protection, withdraw the steam chamber from the top of the Lee’s disc using the forceps and put it on top of the large cork insulating base (K in Figure 1 - 4.2). Put the insulation block on top of the disc and start recording the temperature \( T_{LD} \) over time.

Question 4.2.1.

Select adequate values from the collected data in order to extract the cooling heat current from the disc to the environment at the temperature of the steady state found in Question 4.1.2.

❖ Enter your results in Table under Question 4.2.1. in the answer sheet.

Question 4.2.2.

Plot the data of the Table (Question 4.2.1.) in the provided millimeter paper.

❖ Plot the data in the provided millimeter paper.

Question 4.2.3.

Use your plotted data to evaluate the cooling rate, \( r \), at the steady state found in Question 4.1.2. Present your calculations on the answer sheet, indicating which values you have used.

❖ Enter your calculations and results under Question 4.2.3. in the answer sheet.
Question 4.2.4.

In the answer sheet, write the mathematical expression for the thermal conductivity of the cork sample, $k$, as a function of $m, c$, and any other quantities you got from your experimental data. Using that expression, calculate the thermal conductivity of the cork sample, $k$.

❖ Enter your results under Question 4.2.4. in the answer sheet.

1 - 4.3. Housing Thermal Insulation

Thermal resistance, $R$, of a material is a measure of its thermal insulation against heat losses and can be defined as:

$$ R = \frac{l}{k}, $$

where $k$ is thermal conductivity and $l$ is the slab’s thickness. In buildings, walls are made of different material layers. When the inside and outside wall surfaces are at different temperatures, a heat current $H$ will flow through all the wall layers.

Question 4.3.1.

Find a mathematical expression for the total thermal resistance, $R_{\text{total}}$, of a wall with two layers of thickness $l_1$ and $l_2$, from materials with different thermal conductivities, $k_1$ and $k_2$, respectively, as a function of those quantities only.

❖ Enter your calculations and results under Question 4.3.1. in the answer sheet.

Question 4.3.2.

To prevent losses through thermal conduction, a house with walls made of 20 cm thick concrete and a 2 cm thick plaster drywall, an insulating layer of 1 cm cork board was added. Consider that the concrete side is facing the exterior of the house at a temperature of 0 °C and that inside the house the temperature is kept at 20 °C. Calculate the energy wasted by heat conduction during one hour through a wall with an area of 50 m² for the two following cases:

i) a naked (concrete+plaster, uninsulated) wall;

ii) an insulated (concrete+plaster+cork) wall.

Consider the following thermal conductivities (given in the SI units W K m⁻¹): concrete: 1.10; plaster: 0.17; cork: use the value found in Question 4.2.4.

❖ Enter your calculations and results under Question 4.3.2. in the answer sheet.